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ABSTRACT
This project is termed' utility survey of Royal Valley Estate, Akerebiata road, Sango area, Ilorin. Nigeria '. The accurate location of utilities at a construction site can prevent any damage to the utilities during works. The means of fixing the damage utilities can be very costly and will reduced the expected profit of the construction works. Therefore utility survey using total station is important in providing accurate information of the utilities within the project site. The detected utilities are then shown in the 3-D drawing for better visualization and identification. The project entails reconnaissance, data acquisition, data processing and data. The plan was produced using ArcGIS 10.5 and Auto-Cad. 
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CHAPTER ONE
INTRODUCTION
1.1	BACKGROUND TO THE STUDY 
Utility survey is a vital process for identifying and mapping utilities accurately. By utilizing advanced technology and digital mapping techniques, utility survey helps ensure the safety of construction projects, reduce service disruptions, and enhance overall urban planning and infrastructure management. These mains may include Schools, boreholes, public toilets/latrines. Major investments need to be made in society’s utility supply detail information, such as Schools, boreholes, public toilets/latrines and electricity distribution, etc. Often the geographic location is recorded on inferior quality maps and in some cases it is not documented at all. Certainty of supply, environmental protection and efficiency of operations, however, require good basic data. Excavation damage can be largely avoided when reliable information regarding location and description of utility lines are available. Repair and replacement of utility lines can be carried out in the optimal manner when based on an efficient GIS/utility mapping system (GIS Landmark,2014). The urban surface utilities of the most densely populated modern cities (United States, United Kingdom, China, Japan and etc.) are characterized by many different types of utility networks including electricity cables, gas pipelines, water and sanitary sewer pipelines and street lighting circuits. This growing demand for utility services has resulted in construction of new utility installations, maintenance and repair systems (Lester and Leonard, 2009). Various geophysical tools including electromagnetic induction techniques and ground penetrating radar technology can be utilized to map the position and depth of buried utilities. Each of these techniques has their benefits and limitations but through a careful and diligent application, a comprehensive understanding of subsurface utility network can be Since the advent of civilization, mankind has interacted more with the near-surface part of the Earth's crust than the other deeper layers (Akindulureni et., al,. Therefore, an understanding of the dynamics of this part of the Earth is paramount; industrialization has caused rapid growth, leading to the expansion of man's habitat through the construction of roads, bridges, high-rise buildings, layouts and so on. One of the priority considerations is the design of the foundation for civil engineering structures; therefore, a preconstruction investigation of the proposed site is required in order to ascertain the fitness of the host earth material. This therefore calls for a better understanding of the subsurface geometry and the structural setting in situ. With the rapid urbanization, industries have started relying on more complex and larger utility networks underground. You'll be surprised to know that utility surveying has been with us since the beginning of the 20th century. From underground utility locating and mapping, utility surveying has become an essential step to identify, and map buried infrastructure.(Hussin, Ahamad, & Alhasanat , 2011).
In the early years, people used electromagnetic locator, the very first tool to detect utility maze of pipes and cables underneath the ground. Since its first investigation, the EM field detection theory hasn't been changed. Found in the 1970s, electromagnetic (EM) locator has evolved drastically. Earlier, it used to be a needle-based analogue display whereas, with the advancement in technologies, modern EM locators come with digital display and are more efficient, compact and user-friendly. It now also provides important data like direction, current and strength of the signal. In the early days of utility location services, surveying was done with the help of the only EM locator available in the market and few handy tools. Fiber optics weren't so much popular and thus locators were only locating metallic utilities. Similarly, GPS technology wasn't used widely as it was expensive. Earlier, utility location services provider has simple rules, lift and trace every possible thing to get the required data and leave no room for errors. These still remain the key points of performing any underground utility locating survey. Over the years, the locator has changed while the theory and the methodology remain the same. Ground Penetrating Radar (GPR) is a real-time NDT technique that uses high frequency radio waves, yielding data with very high resolution in a short amount of time. This technique uses electromagnetic waves that travel at a specific velocity determined by the permittivity of the material. GPR can be used in a variety of different media including rock, soil, ice, fresh water, pavements and structures Adepelumi & Fayemi. (2012). It incorporates the geophysical method that uses radar pulses to image the subsurface. This non-destructive method uses electromagnetic radiation within the frequencies of the radio spectrum, and detects the reflected signals from subsurface structures. It can detect objects, changes in material, voids and cracks. GPR Radar measures the depth in terms of the time it takes for a signal to return after emission. The depth in cm or m, depends on soil conditions and how fast the electromagnetic waves can travel through the ground Jeong & Abraham (2004).
GPR which is widely used to detect underground infrastructures, such as underground utilities, consists of an electromagnetic transmitter and receiver. This technology has been used primarily for detecting structural defects, such as voids and cavities in pavement. The principle of detection is the electromagnetic wave which is radiated from a transmitting antenna, and travels through the material at a velocity which is determined primarily by the permittivity of the material. The wave spreads out and travels downwards until it hits an object which has different electrical properties from the surrounding medium, is scattered from the object, and is detected by a receiving antenna. A straight line drawn from the transmitter to the edge of the wave front is called a ray. Rays are used to show the direction of travel of the wave front in any direction away from the transmitting antenna. If the wave hits a buried object, then part of the wave energy is reflected back to the surface, while part of its energy continues to travel downward. The wave that is reflected back to the surface is captured by a receiving antenna, and recorded in a digital storage device for interpretation. GPR waves can reach depths up to 30 meters in low conductivity materials such as dry sand or granite. The depth of the penetration is also determined by the GPR Antenna used. Antennas with low frequencies obtain subsurface reflections from deeper depths. These low frequency antennas are used to investigate the geology of a site such as for locating sinkholes or fractures and to locate large and deep buried objects. Antennas with higher frequencies obtain reflections from shallow depths and have high resolution. These high frequency antennas are used to investigate surface soils and to locate small, large or shallow buried objects such as utilities and also rebars in concrete.
Utility mapping is done to portray the location of the underground utilities obtained from the GPR survey. In order to place such information in the right context and to understand their mutual relationship over a larger area, it is necessary to map their distribution in the terrain (Annan, 2001). These systems become problematic as soils become saturated with pollutants and effluents with very high suspended and dissolved solids causing environmental pollution within the study and even groundwater pollution in some cases. This gave rise to plan to construct a central sewage system within the study area to mitigate this problem and to construct this system successfully an underground utility survey is needed within the study area as presence of other utilities such as gas line, power line etc.. This information will aid the construction engineers for the design and construction of this system.
1.2	STATEMENT OF PROBLEM
Due to the challenge faced by governments, urban planners, and utility providers worldwide. Traditional methods of infrastructure mapping and monitoring, which rely on manual inspections, paper-based records, and static maps, have proven to be inefficient, time-consuming, and prone to inaccuracies. These outdated approaches often lead to poor decision-making, delays in maintenance, and increased operational costs, ultimately affecting service delivery and public safety. This study seeks to address these issues by exploring the role of utility survey in infrastructure management, identifying its benefits and challenges, and providing recommendations for its effective implementation.




1.3	AIM AND OBJECTIVES 
1.3.1	AIM
The aim of the project is to carryout utility survey of Royal valley Estate in order to have a good design and planning of the Estate which will not to affect all facilities in the study area.
1.3.2	OBJECTIVES
The following objectives were considered in order to accomplish the above aim:
1. Project planning 
2. Monumentation 
3 Data acquisition 
4 Data processing 
5 Information presentations
1.4	SCOPE OF THE PROJECT
Based on the purpose and significance of this project, the scope includes;
1 Project planning 
2 Station selection and monumentation
3 Data Acquisition
4 Data downloading and Data processing
5 Data Analysis and information presentation 
1.5	PERSONNEL
The underlisted students of ND II 2025/2025 set are the personnel that participated in the execution of this project. They are: -
	S/N
	NAME
	MATRIC NUMBER
	ROLE

	1
	Olawale Azeez Olamilekan
	ND/23/SGI/FT/0055
	Author

	2
	Muftau Aishat Omowunmi
	ND/23/SGI/FT/0054
	Member

	3
	Olafimihan Emmanuel .O
	ND/23/SGI/FT/0053
	Member

	4
	Rahman Zainab Olamide
	ND/23/SGI/FT/0064
	Member

	5
	Awolusi Taiwo Ireyemi
	ND/23/SGI/FT/0066
	Member

	6
	Muhammed Aishat
	ND/23/SGI/FT/0058
	Member

	7
	Babalola Olamide Grace
	ND/23/SGI/FT/0062
	Member


1.6	STUDY AREA
The study area is Royal valley estate Sango Ilorin, Kwara State, Ilorin East Local Government Area which lies within longitude 08°29’21”E latitude 04°30’50’’N and longitude 08°29’43”E latitude 04°31’01”N.
[image: ][image: ]

                                                                                                                 [image: ]
Fig 1.1:  Map of the Study Area

CHAPTER TWO
LITERATURE REVIEW
The rapid development of electromagnetic technology in the last few years has achieved a new method for exploration geophysics science. In this technology, the electromagnetic pulse is transmitted into the ground and recorded by antenna in the surface. The ground penetrating radar (GPR) method is intensively used on the land in mapping of underground structure, and searching of archaeological objects, pipes, cable, mineral substance, either underground or below sea level (Witten Technologies Inc. (2001). Beneath the surface of urban region and big cities all over the world lies a wide complex network of cables and pipelines which provide the vital utility services that reinforce modern civilized life. An extraordinary call for utility services within the urban region leads to bury an accumulative digit of utility pipelines such as; telecommunication lines, fibre optics, water and gas pipelines electrical cables. Today many of underground utilities have reached its ending practical life which makes it necessary to be replaced or repaired. While new utilities are awaiting installation due to urban development and the advancement of human life style such as; advanced communication technologies. Then an accurate data and info of these utilities is needed for engineers, surveyors, utility owners, or contractors, generally as reference for the excavation work.
Many have not realized the significance of the underground utility detection which is vital before starting any excavation works. A misfortune could take place if the work is ongoing before the underground utilities are located. Basically, underground utility detection is the procedure of recognizing, isolating and labeling the public and private subsurface utility lines which are hidden beneath the ground surface. These lines comprise of electricity distribution cable, telephones, fibre optics and communication lines, water and waste water conduits and major oil and gas pipeline, mass transit, road tunnels and rail etc. (Dharam, Ranjit, Mohamed, March 2020).
An electromagnetic technology is used in GPR system to detect lines among subsurface mediums with differing dielectric constants. GPR system comprise of antenna that houses the receiver and transmitter with a recorder that reproduce the received signal data in form of a graphic display. The instrument employs two antennas offering different detection frequencies. The 700 MHz antenna detects objects with very high resolution but with a smaller depth range. On the other hand, the antenna with a lower frequency (250 MHz) has a lower resolution, but at the same time, it offers a more extensive depth range. Therefore, one can read the resolution and depth information from a given frequency. The resolution of GPR measurements is called the instrumental ability to determine a minimum distance at which two identical targets can be recognized as separate objects. One can distinguish vertical and horizontal resolutions in the increment values of changing antenna frequency and the dielectric constant of the medium. Therefore reliable and accurate information on underground assets is of vital importance for the planning and management of land and the space below its surface. Underground utilities typically reside in the shallow part of such space. They are just one of its many competing uses, which include building basements and interlinking pedestrian corridors, piles, transportation infrastructure, and more (Chandran, 2019).
The presence, layout, and organization of underground utilities directly affect the value that the land can continuously deliver. It may limit the potential for future development and use or the capacity to host new infrastructure and may present significant obstacles, risks, and nuisances for owners, developers, engineers, and users of the land. It is reasonable to expect that the need for reliable information on underground utilities will become increasingly relevant as cities over the world continue to grow, densify, and change. Vertical and in particular underground development is a way to deal with the limited availability of land above ground. Furthermore, ongoing developments such as the introduction of new services such as 5G (Mims, 2019) and district cooling or heating systems (Bradley, 2020; Wee, 2017), the transition to non-fossil energy sources, and the need to replace existing ageing utility infrastructure will only increase the pressure on an often already congested under- ground space. Some cities have responded to these challenges. The City of Helsinki released its first Underground Master Plan in 2011 (City of Helsinki, 2011). The Municipality of Rotterdam has adopted an asset management strategy for the management of underground space and infrastructure. It has a specialized unit coordinating utility developments and the collection of survey data (Rotterdam, 2019).
In Japan, the Road Administration Information Centre coordinates all utility works that occur on roads in metropolitan areas and, to support that, maintains a centralized dataset of all road and utility information (Zeiss, 2019). For the city-state of Singapore, going underground‖ is one of its strategies to deal with limited land availability. The Master Plan 2019 (Urban Redevelopment Authority of Singapore, 2019a) highlighted underground space use as a means to create space for growing needs. The Urban Redevelopment Authority of Singapore (URA) furthermore mentions that planning the underground space upfront in 3D based on BIM and GIS data and the mapping and dissemination of data on shallow utility lines are required to safeguard underground space for future uses and to eliminate uncertainty and risk during the planning process (Urban Redevelopment Authority of Singapore, 2019b). Besides master planning, reliable information on underground utilities is expected to continuously provide value throughout the life cycle of land assets and management.
In Nigeria the lack of pre-construction under-ground utility investigations, which assist engineers in obtaining as-built subsurface information has led to building collapse and structural failures. A number of factors such as subsurface geological material, inadequate information about the soil, poor foundation design and poor building materials have also attributed to this failure (Fatoba et al., 2013). This has led to the loss of life and lots of goods and properties worth millions aside from the cost of rehabilitation or complete redesign and reconstruction at much higher cost.
Recently, the collapse of civil engineering structures has increased greatly for reasons associated with lack of information about subsurface geological and utility data. As a result, the need for subsurface investigation has become very crucial so as to prevent loss of lives and valuable properties that consistently occur with such a failure. Foundation assessment of a new site is required so as to provide subsurface and aerial information that normally assist civil engineers, builders and town planners in the design and citing of foundations of civil engineering structures (Omoyoloye et. al.,2008).
Currently in Nigeria the management and maintenance of underground utilities are non-existence. As more currently there is a water project going on within the city of Port Harcourt without any information taken about the buried utilities, such as the location and size of the facility. This will affect future construction because of the absence of the underground -utility data.







CHAPTER THREE
3.0 	METHODOLOGY 
This aspect refers to a system of methods and principles, rules used in a field of study to achieve the aim and objectives of this project. The modality to successful execute this project was carried out based on the survey rules and regulation, supervisor advice and departmental instructions.
3.1 	RECONNAISSANCE 
Reconnaissance survey is a preliminary stage for exploratory investigations conducted to gather initial data concern the choice of Site area of Subject before more detailed research or filed work commenced. Reasons for reconnaissance survey of the project area are the following;
i. To know the location of the site.
ii. To determine the preliminary area/perimeter of the land.
iii. To know the survey method suitable for the field data acquisition and the instrument need for it.
Reconnaissance in this project involved preliminary investigations to gather information about the survey area before conducting a detailed survey, reconnaissance of this project was carried out in two way namely as follows.
i. Office planning
ii. Field Reconnaissance
3.1.1 	OFFICE PLANNING
It involved the process adopted in the collection of relevant data and specification about the as-built Surveying with the used of traversing survey method. During the office planning the given coordinate for control point PBIL 100, PBIL 107, and PBIL 110, was obtained and computed as shown in the table 3.1 below. The choice of equipment to be use for project was obtained from the survey store in the department of surveying and Geoinformatic, Kwara State Polytechnic, Ilorin, and it was handled accordingly to the survey rules and regulations and departmental instruction.
TABLE 3.1 Showing the list of the coordinate of the control pillars used
	Stations
	Northing (m)
	Easting (m)

	PBIL 100
	939353.130
	648821.110

	PBIL 107
	939306.460
	648932.560

	PBIL 110
	939224.969
	649120.403



3.1.2 	FIELD RECONNAISSANCE 
Field recce and site visitation was conducted as preliminary survey for investigation of the basic information about a specified project area, location, or subject in the field. It allows the members of the groups to be familiar with the terrain, boundary lines, selection number of station required, Equipment that will be used for the job, pillars number PBIL 100, PBIL 107, and PBIL 110, used as a control for the project and so on. The stations points selected was Inter-visible to one another and finally a reconnaissance diagram was produced which was attached to this project
3.2	INSTRUMENT SELECTION
The equipment used for this project was grouped into two categories; 
i. Hardware 
ii. Software
3.2.1	Hardware used 
i. Total Station with its Accessories (KTS-442L)
ii. Reflector poles
iii. Field book
iv. Writing material (pen) 
v. Survey beacons
vi. Steel Tape (5m)
vii. Tripod Stand
3.2.2	Software used 
Below are the lists of the software used during the project processing;
i. AutoCAD 2007
ii. Notepad
iii. Microsoft word
iv. Microsoft Excel
3.3 	INSTRUMENT TEST 
The instrument test was carried out before it used for angular observation. The purpose of testing the instrument before used is to know the assurance and maybe other instrument is in good Condition the instrument was set up over station A and it was pointed a Sighted to station B whore a pole Is hold, and the angle was recorded for face left the instrument was turn to farce right on the same point and it was sighted to station B, where a pole is held at the same position and the angle was recorded. The distance between station A and B 1s 10m. The steel tape was hold at 60m an point A and it was extend to point B. the results for the instrument test was shown i to figure 3.3 below and table 3:2 below.
 (
Total station
LINE OF SIGHT
RANGING POLE
20M
STATION  X
TERRAIN
STATION  Y
)







Figure 3.1 showing the instrument set up for collimation test 
Table 3.2 showing the test of instrument result 
	STATION
	SIGHT
	FACE
	HORIZONTAL READING
	DEDUCED ANGLE

	A
	B
	L
	180 00’ 03”
	

	
	B
	R
	0000’ 00”
	180 00’ 03”


Different in horizontal circle reading: 180° 00’ 03’’
Horizontal collimation error 
= 180° 00’ 03’’
= 000° 00 03’’
	Collimation error = 
Horizontal collimation error = 00 00’ 01”
Because the collimation error falls within the allowable 01”. The instrument was in good condition.



3.4 	MONUMENTATION 
 (
18cm
15cm above the ground
60cm below the ground
18cm
)This is the process in which the beacon is being buried in to ground. On the project site there are same existing beacons on the boundary lines m, nail with cap (bottle cork) was used as the station pegs.
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PILLAR							   PEG
	FIGURE 3.4	Diagram and Dimension of Pillars buried
3.5 	CONTROL CHECK 
The Control check was carried out to know the control point PBIL 100, PBIL 107, and PBIL 110, are still in their positions. The instrument was set on Control FP01107 and the temporary adjustment was carried out i.e centring, levelling, and focusing. Back site was taken to control PBIL 107 and it was recorded.
The fore sight was served to PEG1 and it was recorded Steel tape was used to measure the distance between PBIL 110 and PEGI and it was recorded. The data observed was computed for given coordinate and Observed Coordinate, as shown in the table 3.2 below.
TABLE 3.2	THE GIVEN COORDINATE OF THE CONTROL POINTS
	STATION
	NORTHING (m)
	EASTING (m)

	PBI 100
	939353.130
	648821.110

	PBIL 107
	939306.460
	648932.560

	PBIL 110
	939224.969
	649120.403



TABLE 3.3	The Backward Computation for the Given Controls pillars
	From station
	Bearing
	Distance
	
	
	Northing
      (m)
	Easting
     (m)
	To station

	
	
	
	
	
	899353.130
	688821.110
	PBIL 100

	PBIL 100
	1120 43̍ 17 ̎
	120.827
	-46.670
	111.450
	899306.460
	688932.560
	PBIL 107

	PBIL 107
	1130 27̍ 09 ̎
	204.758
	-81.491
	187.843
	899224.969
	689120.403
	PBIL 110


	PBIL 100 to PBIL 107
	BEARING = 1120 43̍ 17 ̎ 
	DISTANCE = 120.827m
	PBIL 107 to PBIL 110
	BEARING = 1130 27̍ 09 ̎ 
	DISTANCE = 204.758m
TABLE 3.4	Show the Observed Coordinate of the Controls Pillars
	Station
	Northing (m)
	Easting (m)

	PBIL 100
	939353.126
	648821.105

	PBIL 107
	939306.460
	648932.560

	PBIL 110
	939224.969
	649120.403



TABLE 3.5	Show the Backward Computation for the Observed Control Pillars
	From station
	Bearing
	Distance
	
	
	Northing
       (m)
	Easting
     (m)
	To station

	
	
	
	
	
	899353.126
	688821.105
	PBIL 100

	PBIL 100
	1120 43̍ 08 ̎
	120.830
	-46.666
	111.455
	899306.460
	688932.560
	PBIL 107

	PBIL 107
	1130 27̍ 09 ̎
	204.758
	-81.491
	187.843
	899224.969
	689120.403
	PBIL 110


	PBIL 100 to PBIL 107
	BEARING = 1120 43̍ 08 ̎ 
	DISTANCE = 120.830m
	PBIL 107 to PBIL 110
	BEARING = 1130 27̍ 09 ̎ 
	DISTANCE = 204.758m
TABLE 3.6	Show the Difference between the Given Control Points and the Observed Control Pillars
	STATION
	NORTHING (m)
	EASTING (m)

	PBIL 100
	0.004
	0.005

	PBIL 107
	0.000
	0.000

	PBIL 110
	0.000
	0.000



Therefore the difference between the given and observer bearing was 00 00’ 09” and 00 00’ 00” and the difference between the given and the observer linear distance was 0.0003m, 0.000m the results obtained fall within the allowable accuracy for both angular and linear observation.
It was concluded the instrument was in good condition and fit to be used for the project.  
3.6 	DATA AQUISITION 
This was carried out on the field using Total station with its accessories (KTS-442L) was used for coordinating the entire site for both the perimeter and details of the site. The Total station was set on the 	control Pillar PBIL 107, and the temporary adjustment was carried out centering, leveling and 	focusing. The coordinates of the occupied station was input after that the coordinates of the backsight was record as well and the observation was done to backsight pillar and the coordinates was take and check against the given. Having check and found accurate then the perimeter survey commenced for the entire project site.
3.6.1	DETAILING SURVEY
The detailing survey was done immediately after completely carried out the perimeter traverse to determine the position of the features on the Site was fixed using radiation survey method. During this several stations was established to pick the coordinates of the details and the coordinates was stored on the total station as its observed. This was later downloaded. The details that was picked during the detailing survey was coded in different ways like Building edges as ‘BLD’, Electric Poles ‘EP’, Drainage ‘DR’, Roads Line ‘RD’, Spot Height ‘SP’ and so on.

CHAPTER FOUR
4.0   	DATA PROCESSING 
This involved several step to ensure accurate and reliable result. It explains the method used in capturing, processing, downloading, and analyzing the data acquired Data reduction in surveying involves various methods to simplify and summarize the collected data for analysis. These are some common methods of data reduction that involves  
· Combining multiple values into a single value. The average value is calculated by summing up all the values and dividing by the number of values.
· Least Square Adjustment (LSA) is a method of data reduction that involves minimizing the sum of the squared errors between observed and calculated values.
· Interpolation is a method of data reduction that involves estimating values between observed data points. 
· Spatial data reduction refers to the process of simplifying and reducing the complexity of spatial data, such as geographic information system (GIS) data, while preserving its essential characteristics.
4.1	DATA EDITING 
· Open excel
· Click on the desire file
· Set to delimited 
· Click on next
· Mack space and comma
· Click
· On next
· Then click on finish
4.3	DATA PROCESSING USING AUTOCAD
The plan produced digitally with AutoCAD software. The following are the procedure used:
STEP 1: Open Notepad
Open Notepad on your computer. You can find it in the start menu (Window)
STEP 2: Create a New File
Click on "file" "New" to create a new file
STEP3: Enter Coordinates
Enter your coordinates in the following format:
X. Y. Data
STEP 4: Save the Fil
Click on "File" > "Save as" and choose a location to save your file. "ALADA Coordinate" txt, 	and select "All files" as the file type.
	Importing the Coordinate File Into 2007 AutoCAD
	STEP 1: Double click AutoCAD
	Go under format
	Click on format after that pick your unit
	Drawing unit
	Type.... Decimal
	Precision... 0.000
	Angle type Degree/Min/See
	Precision Od00
	Clockwise.... 노
	Unit to scale Meters
	Direction control North 270d0
	Press "OK"
	STEP 2: Create a new drawing
	Click on "File" > "Name" to create a new drawing
	STEP 3: Import the coordinate file
Click on "Tools" >"Reference" > "Import" and select "ALADA coordinate (.txt)" as the file 	type. Navigate to the location where you saved your coordinate file ("ALADA coordinate .txt") 	and select it.
STEP 4: Configure Import Setting. In the import select "Point" as the object type and choose 	the correct coordinate format (eg. X and Y) click "OK" to import the coordinates.
4.4	DATA EXTRACTION
The data recorded in the field book was picked to compute for the bearing and distance. Forward computation and backward computation after all necessary correction have been applied. Correction like slope correction, tension correction and standardization correction.
4.3  	BACK COMPUTATION 
The result get for forward computation was used for Back computation.
The following program was required for back computation 
i. Input N2-N1 to get N
ii. Input E2-E1 to get E
iii.Input to get distance 
iv.Input shift tan to get the corrected bearing when there us more station repeat step ¡¡¡ and ii.
Table 4.1 Showing Boundary Coordinates
	Station 
	Northing (m)
	Easting(m)

	PBIL107
	939366.406
	648932.560

	PL1
	939240.312
	648901.750

	PL2
	939309.331
	648780.785

	PL3
	939292.197
	648603.139

	PL4
	939438.718
	648619.716

	PL5
	939467.847
	648693.558

	PL 6
	939353.126
	648821.105



Table 4.1.1 Showing back computation for the boundary coordinate  
	FROM Station 
	BEARING 
	DISTANCE 
	ΔN
	ΔE
	Easting
	Northing
	TO STATION

	
	
	
	
	
	648932.560
	939366.406
	PBIL 107

	PBIL 107
	204 58 29
	72.971
	-66.148
	30.810
	648901.750
	939240.312
	PL1

	PL1
	299 42 28
	139.270
	69.019
	120.965
	648780.785
	939309.331
	PL2

	PL2
	295 39 02
	193.739
	83.866
	174.646
	648603.139
	939292.197
	PL3

	PL3
	16 40 37
	47.520
	45.521
	13.637
	648619.716
	939438.718
	PL4

	PL4
	112 42 17
	79.980
	30.871
	73.782
	648693.558
	939467.847
	PL5

	PL5
	113 13 14
	113.790
	54.721
	127.547
	648821.105
	939353.126
	PL6

	[bookmark: _GoBack]PL6
	112 43 59
	120.870
	48.666
	45.500
	648932.560
	939366.406
	PBIL 107




TABLE 4.1.2: showing area computation for the boundary coordination using double latitude 
	ΔN
	ΔE
	product

	66.148
	× - 30.810
	= 2038.020

	66.148
	
	

	69.019
	
	

	-63.277
	× - 120.965
	=7654.302

	69.619
	
	

	83.866
	
	

	89.608
	× -174.646
	-=15649.679

	83.866
	
	

	45.521
	
	

	218.995
	× 13.637
	=2986.435

	45.521
	
	

	-30.871
	
	

	233.645
	× 73.782
	=17238.792

	-30.871
	
	

	-54.721
	
	

	148.653
	× 127.547
	=18883.716

	-54.721
	
	

	-46.666
	
	

	46.666
	× 111.455
	=5201.159

	-46.666
	
	

	00.000
	
	



Area = 




	=19176.374=> 1.9 hectares
	1.9 Hectares
Hectare=

= 1.9176374 Hectare

Linear Accuracy = 

EL=EDN=0.066
ED=EDE=0.072
Total length =793.100

 = 
=1:8000
CHAPTER FIVE
SUMMARY, PROBLEMS ENCOUNTERRED, CONCLUSION, RECOMMENDATIONS
5.1 	SUMMARY 
This study was carried out to determine the utilities within the study area and produced a map depicting the position, depth and size of the underground facilities in focus. The plan showing the utilities and facilities was produced with appropriate colour code. It can be concluded that total station equipment was used to acquire the data of the utilities. The technique used is efficient and non-destructive for locating utilities in the study area. It is advisable to perform utility survey before carrying out any works in order to avoid damage to the utilities which can be quite expensive to fix. 
5.2 	PROBLEM ENCOUNTERED 
i. Too much of rainfall which does not allowed site
ii. Unavailable of the group members due to rector’s cup football tournament
iii. While taking observing there are some object obstructing the view when taking the observation e.g electric pole, building, tree etc.
5.3 	RECOMMENDATIONS
As a matter of fact, utility survey should be encouraged within the city as they form the foundation within which modern cities are built. Also, there should be awareness on the importance of the utility survey, especially during road construction going within our city. 


5.4 	CONCLUSION 
At the end the aim and objective of this project was achieved. It was carried out using third order surveying method this project was carried out in accordance with survey rules and regulation and departmental instruction.
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APPENDIX

	Name
	Code
	E
	N
	h
	 
	PT260
	SH
	668115.4
	937791.5
	317.946

	PT1
	ST17
	668069.6
	937900.4
	324.137
	 
	PT261
	SH
	668118
	937790.7
	318.041

	PT2
	CV
	668071.1
	937900.4
	324.553
	 
	PT262
	SH
	668117.7
	937795.6
	317.967

	PT3
	CV
	668072
	937900.3
	324.541
	 
	PT263
	SH
	668113.5
	937797.2
	317.656

	PT4
	BLD
	668072.6
	937900.6
	324.383
	 
	PT264
	SH
	668110.1
	937800.8
	317.647

	PT5
	BLD
	668066.5
	937905.8
	323.724
	 
	PT265
	SH
	668110.4
	937806.9
	317.571

	PT6
	SH
	668069.7
	937897.9
	324
	 
	PT266
	SH
	668114.1
	937808.4
	317.326

	PT7
	SH
	668072.6
	937896.1
	324.671
	 
	PT267
	SH
	668117.8
	937810
	317.601

	PT8
	SH
	668072.2
	937891.5
	324.604
	 
	PT268
	SH
	668117.6
	937814.7
	317.532

	PT9
	SH
	668076.5
	937892.6
	324.821
	 
	PT269
	SH
	668113.8
	937816
	317.212

	PT10
	SH
	668083.2
	937892.3
	324.831
	 
	PT270
	SH
	668109
	937815.1
	317.485

	PT11
	SH
	668085.6
	937889.4
	324.87
	 
	PT271
	SH
	668104.5
	937814.4
	317.27

	PT12
	BLD
	668085.4
	937886.8
	324.848
	 
	PT272
	SH
	668104.8
	937819.5
	317.197

	PT13
	SH
	668088.7
	937888.5
	324.887
	 
	PT273
	SH
	668109.7
	937818.5
	317.278

	PT14
	SH
	668090.4
	937893.3
	324.882
	 
	PT274
	SH
	668113.6
	937819
	317.192

	PT15
	SH
	668095.3
	937895.1
	324.957
	 
	PT275
	SH
	668117.7
	937821.2
	317.334

	PT16
	SH
	668095.6
	937891.4
	324.958
	 
	PT276
	SH
	668114.1
	937823.2
	317.152

	PT17
	BLD
	668139.4
	937901.3
	324.586
	 
	PT277
	SH
	668109
	937824.1
	317.181

	PT18
	CV
	668139.1
	937901.2
	316.047
	 
	PT278
	SH
	668104.9
	937822.2
	317.161

	PT19
	CV
	668139.5
	937900.4
	316.104
	 
	PT279
	SH
	668105
	937825.4
	317.107

	PT20
	CV
	668137.3
	937899
	317.048
	 
	PT280
	SH
	668103.5
	937827.1
	317.276

	PT21
	SH
	668133.7
	937894.7
	316.106
	 
	PT281
	SH
	668108.1
	937827.2
	317.179

	PT22
	SH
	668136.7
	937894.8
	316.021
	 
	PT282
	SH
	668112
	937827.1
	317.097

	PT23
	BLD
	668137
	937893.5
	316.015
	 
	PT283
	SH
	668116.6
	937827.5
	317.116

	PT24
	SH
	668141.1
	937890.4
	315.886
	 
	PT284
	SH
	668117.8
	937831.4
	317.048

	PT25
	SH
	668145.9
	937889.2
	315.599
	 
	PT285
	SH
	668112.9
	937833.2
	317.012

	PT26
	SH
	668147.8
	937891.6
	315.619
	 
	PT286
	SH
	668108.8
	937832.7
	317.058

	PT27
	GT
	668148.7
	937893.4
	315.804
	 
	PT287
	SH
	668106.3
	937831.7
	317.095

	PT28
	GT
	668147.9
	937894
	315.765
	 
	PT288
	SH
	668120.4
	937780
	318.343

	PT29
	BLD
	668148.9
	937893.2
	315.928
	 
	PT289
	SH
	668125.9
	937783
	318.036

	PT30
	SH
	668148.1
	937886.3
	315.852
	 
	PT290
	SH
	668122.6
	937785.4
	318.043

	PT31
	SH
	668144.4
	937882.9
	315.942
	 
	PT291
	SH
	668120.9
	937789.4
	318.013

	PT32
	SH
	668140.3
	937879.1
	316.287
	 
	PT292
	BLD
	668120.6
	937791.6
	317.908

	PT33
	SH
	668144.4
	937877.2
	316.236
	 
	PT293
	SH
	668125
	937790.3
	317.853

	PT34
	SH
	668147.4
	937877.9
	316.065
	 
	PT294
	SH
	668128.5
	937785.7
	317.944

	PT35
	BLD
	668149.4
	937879.9
	315.956
	 
	PT295
	SH
	668133
	937781.5
	317.952

	PT36
	BLD
	668156.1
	937879.6
	315.966
	 
	PT296
	SH
	668132.9
	937786.5
	317.857

	PT37
	BLD
	668156
	937874.1
	315.966
	 
	PT297
	SH
	668132.2
	937790.7
	317.807

	PT38
	EP
	668150.9
	937875.2
	316.093
	 
	PT298
	SH
	668137
	937790.8
	317.772

	PT39
	SH
	668152
	937878.1
	315.912
	 
	PT299
	SH
	668139.7
	937786.5
	317.824

	PT40
	BLD
	668146.3
	937874.1
	316.297
	 
	PT300
	SH
	668140
	937781.4
	318.046

	PT41
	SH
	668132
	937896.8
	316.129
	 
	PT301
	SH
	668144.3
	937781.2
	318.023

	PT42
	BLD
	668128.4
	937894.7
	316.378
	 
	PT302
	SH
	668145.5
	937786.4
	317.727

	PT43
	SH
	668124.8
	937894.3
	316.451
	 
	PT303
	SH
	668146
	937791.2
	317.717

	PT44
	SH
	668121.3
	937892
	316.499
	 
	PT304
	SH
	668149.5
	937790.8
	317.75

	PT45
	SH
	668118.3
	937894.3
	316.594
	 
	PT305
	SH
	668149.7
	937786.7
	317.692

	PT46
	SH
	668115.7
	937888.6
	316.573
	 
	PT306
	SH
	668148.9
	937781.3
	317.842

	PT47
	BLD
	668113.6
	937886.9
	316.529
	 
	PT307
	BLD
	668150.4
	937781.4
	317.8

	PT48
	SH
	668110.4
	937889.4
	316.736
	 
	PT308
	BLD
	668150
	937791.5
	317.803

	PT49
	SH
	668108.3
	937891.8
	316.596
	 
	PT309
	SH
	668113.7
	937768.9
	318.789

	PT50
	SH
	668104.4
	937892.2
	316.593
	 
	PT310
	SH
	668113.6
	937766
	318.901

	PT51
	SH
	668104.2
	937889.1
	316.626
	 
	PT311
	BLD
	668112.8
	937763.3
	319.05

	PT52
	SH
	668117.5
	937886.8
	316.551
	 
	PT312
	SH
	668117.2
	937761.4
	318.943

	PT53
	SH
	668119.7
	937883.9
	316.541
	 
	PT313
	SH
	668117.5
	937764.3
	318.911

	PT54
	SH
	668117.1
	937883.2
	316.562
	 
	PT314
	SH
	668122.4
	937765.5
	318.977

	PT55
	SH
	668114.2
	937882.6
	316.592
	 
	PT315
	SH
	668124.5
	937762.3
	318.933

	PT56
	BLD
	668113.5
	937874.4
	316.659
	 
	PT316
	SH
	668122.4
	937758.6
	318.969

	PT57
	SH
	668115.5
	937874
	316.641
	 
	PT317
	SH
	668121.7
	937753.2
	319.012

	PT58
	SH
	668117.6
	937873.9
	316.666
	 
	PT318
	SH
	668119.4
	937752.3
	319.022

	PT59
	SH
	668116.9
	937866.3
	316.759
	 
	PT319
	BLD
	668113
	937752.1
	319.283

	PT60
	SH
	668114.9
	937865.7
	316.81
	 
	PT320
	BLD
	668113.1
	937748.7
	319.275

	PT61
	SH
	668112.2
	937865.8
	317.066
	 
	PT321
	BLD
	668113.2
	937730.1
	319.819

	PT62
	BLD
	668111.7
	937870.2
	316.664
	 
	PT322
	BLD
	668118.1
	937726.7
	320.172

	PT63
	SH
	668124
	937868.3
	316.542
	 
	PT323
	BLD
	668118.2
	937750.2
	319.117

	PT64
	BLD
	668129.2
	937867.4
	316.594
	 
	PT324
	SH
	668122.5
	937751.6
	319.006

	PT65
	SH
	668128.1
	937869.8
	316.579
	 
	PT325
	SH
	668124.5
	937754.3
	318.972

	PT66
	SH
	668127.9
	937872.5
	316.566
	 
	PT326
	SH
	668125.4
	937757
	318.942

	PT67
	SH
	668125
	937873.8
	316.569
	 
	PT327
	SH
	668126.4
	937759.8
	318.902

	PT68
	SH
	668123.6
	937877
	316.822
	 
	PT328
	SH
	668127.7
	937763.6
	318.945

	PT69
	SH
	668126
	937879.4
	316.682
	 
	PT329
	SH
	668129.6
	937766.7
	319.003

	PT70
	SH
	668121.7
	937869.6
	316.558
	 
	PT330
	SH
	668132.3
	937766.4
	319.052

	PT71
	SH
	668121.5
	937862
	316.817
	 
	PT331
	SH
	668132.9
	937763.9
	319.098

	PT72
	SH
	668123.1
	937858.4
	316.857
	 
	PT332
	SH
	668133.1
	937760.8
	318.995

	PT73
	SH
	668118.9
	937856.2
	316.91
	 
	PT333
	SH
	668133.8
	937757.1
	318.991

	PT74
	BLD
	668120.4
	937852
	316.833
	 
	PT334
	SH
	668134
	937753.4
	318.981

	PT75
	SH
	668116.8
	937852.9
	316.833
	 
	PT335
	SH
	668134.5
	937750.7
	319.07

	PT76
	CV
	668119
	937855.1
	316.791
	 
	PT336
	BLD
	668137.6
	937750.4
	319.035

	PT77
	CV
	668118.5
	937855.2
	316.819
	 
	PT337
	SH
	668138.2
	937752.8
	319.024

	PT78
	SH
	668111.8
	937851.5
	317.396
	 
	PT338
	BLD
	668140.6
	937755.3
	318.91

	PT79
	SH
	668115.7
	937850.6
	316.866
	 
	PT339
	SH
	668137.7
	937757.7
	319.018

	PT80
	SH
	668118.3
	937849
	316.835
	 
	PT340
	SH
	668136
	937762
	319.013

	PT81
	SH
	668118.1
	937843.1
	316.939
	 
	PT341
	SH
	668138.3
	937764.7
	319.044

	PT82
	SH
	668113.8
	937842.7
	316.91
	 
	PT342
	BLD
	668139.4
	937765.7
	319.051

	PT83
	SH
	668108.1
	937843.3
	317.4
	 
	PT343
	SH
	668141.4
	937749.2
	319.111

	PT84
	SH
	668106.1
	937847.2
	317.641
	 
	PT344
	SH
	668143.4
	937751
	319.05

	PT85
	SH
	668102.4
	937849.2
	317.563
	 
	PT345
	SH
	668144.9
	937753.8
	318.948

	PT86
	SH
	668101.2
	937843.6
	317.586
	 
	PT346
	SH
	668147.2
	937751.6
	318.691

	PT87
	SH
	668099.2
	937840.3
	317.489
	 
	PT347
	SH
	668146.9
	937747.9
	319.135

	PT88
	SH
	668098.1
	937836.4
	317.051
	 
	PT348
	SH
	668144.5
	937745.9
	319.098

	PT89
	SH
	668094.9
	937829.9
	317.405
	 
	PT349
	SH
	668143.8
	937741.8
	319.252

	PT90
	SH
	668099
	937830
	317.366
	 
	PT350
	BLD
	668137.8
	937739.5
	319.454

	PT91
	SH
	668102.2
	937835.3
	317
	 
	PT351
	SH
	668140
	937740.1
	319.295

	PT92
	SH
	668093
	937842.7
	317.597
	 
	PT352
	SH
	668141.4
	937742
	319.263

	PT93
	SH
	668090.5
	937849.3
	317.02
	 
	PT353
	SH
	668145.1
	937740.6
	319.475

	PT94
	SH
	668088
	937845.4
	317.154
	 
	PT354
	SH
	668147.6
	937743.1
	319.297

	PT95
	CV
	668089.1
	937840.1
	317.01
	 
	PT355
	SH
	668149.8
	937746.8
	319.15

	PT96
	CV
	668089.5
	937840.1
	317.036
	 
	PT356
	SH
	668151.4
	937750.4
	319.144

	PT97
	CV
	668089.7
	937835.1
	316.97
	 
	PT357
	SH
	668153.9
	937753.9
	319.13

	PT98
	CV
	668089.1
	937835.1
	316.951
	 
	PT358
	BLD
	668156.8
	937753.8
	319.16

	PT99
	SH
	668087.3
	937837.4
	317.032
	 
	PT359
	BLD
	668155
	937750.1
	319.175

	PT100
	SH
	668084.9
	937841.3
	317.015
	 
	PT360
	GT
	668156.7
	937750.4
	319.189

	PT101
	SH
	668081.1
	937845.6
	316.694
	 
	PT361
	GT
	668156.4
	937744
	319.379

	PT102
	BLD
	668082.4
	937849.5
	316.774
	 
	PT362
	BLD
	668151.3
	937744.1
	319.293

	PT103
	SH
	668079.2
	937850.8
	316.576
	 
	PT363
	BLD
	668157.6
	937720.9
	319.595

	PT104
	SH
	668076.3
	937851.1
	316.606
	 
	PT364
	BLD
	668075.3
	937717.9
	320.555

	PT105
	SH
	668076.4
	937857.2
	316.522
	 
	PT365
	BLD
	668042.2
	937720.6
	320.353

	PT106
	SH
	668079.6
	937859
	316.481
	 
	PT366
	BLD
	668036
	937729.4
	320.261

	PT107
	SH
	668082.3
	937859.3
	316.539
	 
	PT367
	BLD
	668035.2
	937744.9
	319.623

	PT108
	SH
	668081.6
	937865.3
	316.444
	 
	PT368
	BLD
	668011
	937744.6
	320.389

	PT109
	SH
	668078.7
	937867
	316.454
	 
	PT369
	BLD
	668000.4
	937749.6
	319.55

	PT110
	SH
	668075.8
	937866.3
	316.351
	 
	PT370
	BLD
	667993.6
	937757.8
	318.942

	PT111
	SH
	668074
	937869.4
	316.329
	 
	PT371
	BLD
	667980.6
	937772.8
	318.59

	PT112
	SH
	668078.7
	937870.4
	316.547
	 
	PT372
	BLD
	667974.3
	937782.4
	318.279

	PT113
	SH
	668081.1
	937872.7
	316.472
	 
	PT373
	BLD
	667968.1
	937789.6
	318.03

	PT114
	SH
	668081.9
	937877.2
	316.469
	 
	PT374
	RD
	667966.1
	937793.6
	317.734

	PT115
	SH
	668079
	937877.3
	316.472
	 
	PT375
	CL
	667964.4
	937795.8
	317.839

	PT116
	SH
	668076.3
	937876
	316.604
	 
	PT376
	RD
	667962.9
	937797.2
	317.658

	PT117
	EP
	668074.3
	937876.1
	316.594
	 
	PT377
	SH
	667967.3
	937798.1
	317.599

	PT118
	TM
	668071.8
	937879
	316.342
	 
	PT378
	SH
	667972.1
	937795.5
	317.821

	PT119
	TM
	668076.7
	937878.8
	316.445
	 
	PT379
	SH
	667976.9
	937798.1
	317.559

	PT120
	TM
	668077.2
	937885.8
	316.536
	 
	PT380
	SH
	667975.5
	937802
	317.229

	PT121
	SH
	668079.9
	937885
	316.362
	 
	PT381
	SH
	667973.8
	937805.3
	317.111

	PT122
	SH
	668082.8
	937883.4
	316.48
	 
	PT382
	SH
	667974.4
	937809.3
	317.087

	PT123
	SH
	668079.8
	937880.6
	316.437
	 
	PT383
	SH
	667980.3
	937808.6
	317.008

	PT124
	SH
	668064.8
	937896.9
	315.429
	 
	PT384
	SH
	667986.3
	937808.3
	317.055

	PT125
	BLD
	668064.8
	937885.4
	315.743
	 
	PT385
	SH
	667989
	937806.7
	317.471

	PT126
	SH
	668069.7
	937888.7
	315.93
	 
	PT386
	SH
	667991.4
	937808.2
	317.321

	PT127
	SH
	668069.8
	937882.8
	315.817
	 
	PT387
	BLD
	667995.8
	937809.1
	317.181

	PT128
	EP
	668066.9
	937881.4
	316.367
	 
	PT388
	BLD
	667996.6
	937819.4
	317.014

	PT129
	BLD
	668073.2
	937873.9
	316.28
	 
	PT389
	BLD
	667997.1
	937825.8
	316.715

	PT130
	SH
	668076.5
	937842.5
	316.803
	 
	PT390
	BLD
	667997.7
	937836.1
	316.436

	PT131
	SH
	668080.9
	937837.3
	316.882
	 
	PT391
	SH
	667999.8
	937837.9
	316.489

	PT132
	SH
	668076.4
	937833.4
	317.117
	 
	PT392
	SH
	668004.1
	937837
	316.697

	PT133
	SH
	668079.1
	937829.3
	317.088
	 
	PT393
	SH
	668006.3
	937835.7
	316.836

	PT134
	SH
	668084.6
	937829.3
	317.095
	 
	PT394
	SH
	668012.2
	937839.5
	317.101

	PT135
	SH
	668084.6
	937825.2
	317.166
	 
	PT395
	BLD
	668024
	937834.2
	316.943

	PT136
	SH
	668080.9
	937824.4
	317.192
	 
	PT396
	EP
	668028.4
	937833.8
	316.701

	PT137
	EP
	668075.2
	937830.8
	317.409
	 
	PT397
	SH
	668027.3
	937830.5
	316.834

	PT138
	SH
	668076.5
	937824.8
	317.309
	 
	PT398
	SH
	668024.8
	937827.5
	316.95

	PT139
	SH
	668080.1
	937820.9
	317.285
	 
	PT399
	SH
	668027.4
	937825.1
	316.977

	PT140
	SH
	668083.9
	937818.9
	317.208
	 
	PT400
	SH
	668025.7
	937818
	317.088

	PT141
	SH
	668084.3
	937814.6
	317.38
	 
	PT401
	BLD
	668022.6
	937817.1
	317.238

	PT142
	SH
	668080.3
	937812.9
	317.483
	 
	PT402
	SH
	668025.6
	937813.3
	317.258

	PT143
	SH
	668077
	937811.8
	317.722
	 
	PT403
	SH
	668030.1
	937809.1
	317.516

	PT144
	EP
	668075.5
	937812.1
	317.622
	 
	PT404
	BLD
	668031.1
	937802.8
	317.66

	PT145
	CV
	668075.9
	937810.5
	317.869
	 
	PT405
	SH
	668027.5
	937801.2
	317.556

	PT146
	CV
	668076.6
	937810.4
	317.877
	 
	PT406
	SH
	668031.4
	937799.3
	317.671

	PT147
	CV
	668076.1
	937808
	317.884
	 
	PT407
	BLD
	668035
	937801.7
	318.075

	PT148
	CV
	668076.5
	937808
	317.896
	 
	PT408
	SH
	668032
	937800
	317.586

	PT149
	BLD
	668073.4
	937815.4
	317.468
	 
	PT409
	SH
	668031.4
	937796
	317.74

	PT150
	BLD
	668073.5
	937803.4
	317.824
	 
	PT410
	SH
	668033.4
	937793.9
	317.725

	PT151
	SH
	668077.3
	937804.7
	317.737
	 
	PT411
	BLD
	668035.2
	937792.8
	317.863

	PT152
	SH
	668080.4
	937805.5
	317.546
	 
	PT412
	BLD
	668029.7
	937792.2
	318.048

	PT153
	SH
	668083.8
	937807.7
	317.514
	 
	PT413
	BLD
	668029.5
	937779.7
	318.482

	PT154
	SH
	668084
	937803.1
	317.576
	 
	PT414
	BLD
	668035.6
	937839.2
	316.76

	PT155
	SH
	668080.5
	937801.9
	317.645
	 
	PT415
	BLD
	668030
	937849.5
	316.014

	PT156
	SH
	668076.8
	937799.4
	318.005
	 
	PT416
	BLD
	668014.7
	937849.8
	315.771

	PT157
	SH
	668080.5
	937797
	317.729
	 
	PT417
	RD
	668001.4
	937850
	315.553

	PT158
	SH
	668084.2
	937798.5
	317.584
	 
	PT418
	RD
	667996.5
	937852.3
	315.646

	PT159
	SH
	668086.6
	937795.5
	317.625
	 
	PT419
	BLD
	668015.4
	937870.2
	315.216

	PT160
	SH
	668088.9
	937794.7
	317.784
	 
	PT420
	RD
	668022.4
	937889
	314.617

	PT161
	SH
	668087.8
	937791.7
	318.04
	 
	PT421
	RD
	668020.3
	937890.7
	314.467

	PT162
	BLD
	668090.2
	937790.5
	318.057
	 
	PT422
	BLD
	668035.6
	937896.8
	314.523

	PT163
	SH
	668086
	937790
	318.019
	 
	PT423
	CV
	668032.5
	937898.1
	314.441

	PT164
	SH
	668079.9
	937790.6
	317.829
	 
	PT424
	CV
	668032.1
	937898.6
	314.354

	PT165
	SH
	668076.8
	937791.1
	317.997
	 
	PT425
	EP
	668026.8
	937902.6
	314.367

	PT166
	EP
	668075.9
	937791.5
	318.028
	 
	PT426
	EP
	668042.4
	937923.4
	313.423

	PT167
	SH
	668081.3
	937788.3
	317.911
	 
	PT427
	EP
	668045.7
	937913.1
	313.825

	PT168
	SH
	668086.2
	937787
	318.037
	 
	PT428
	CV
	668045.7
	937915.3
	314.041

	PT169
	SH
	668088.3
	937782.1
	318.256
	 
	PT429
	CV
	668045.2
	937915.7
	314.017

	PT170
	SH
	668083.1
	937782.1
	318.113
	 
	PT430
	RD
	668050.4
	937924.9
	313.193

	PT171
	SH
	668077.2
	937783.1
	318.448
	 
	PT431
	RD
	668048
	937928.1
	313.163

	PT172
	SH
	668077.1
	937779.4
	318.482
	 
	PT432
	CL
	668049.6
	937927.2
	313.142

	PT173
	SH
	668080.8
	937779.2
	318.382
	 
	PT433
	BLD
	668057.8
	937924.9
	313.443

	PT174
	SH
	668086.1
	937777
	318.527
	 
	PT434
	BLD
	668139.5
	937920.4
	313.76

	PT175
	SH
	668088.4
	937774.7
	318.351
	 
	PT435
	BD
	668156.3
	937920.7
	312.957

	PT176
	CV
	668076.7
	937775.7
	318.733
	 
	PT436
	BLD
	668156.4
	937893.6
	315.143

	PT177
	CV
	668076.4
	937775.7
	318.755
	 
	PT437
	BLD
	668120.5
	937803.6
	317.77

	PT178
	SH
	668075.6
	937773.1
	318.598
	 
	PT438
	SH
	668121.8
	937806.3
	317.702

	PT179
	BLD
	668073.5
	937768.6
	318.708
	 
	PT439
	BLD
	668120.3
	937810
	317.679

	PT180
	SH
	668073.1
	937767.9
	318.686
	 
	PT440
	SH
	668124.2
	937808.2
	317.693

	PT181
	SH
	668075.1
	937765.4
	318.807
	 
	PT441
	SH
	668124.2
	937805.5
	317.683

	PT182
	BLD
	668076.2
	937763
	318.99
	 
	PT442
	SH
	668127.7
	937808.3
	317.623

	PT183
	SH
	668077.8
	937762.3
	318.92
	 
	PT443
	SH
	668129.9
	937805.3
	317.555

	PT184
	SH
	668079.4
	937758.5
	319.226
	 
	PT444
	SH
	668132.3
	937808.2
	317.557

	PT185
	SH
	668076.9
	937758.6
	318.98
	 
	PT445
	SH
	668135.2
	937805
	317.569

	PT186
	SH
	668079.6
	937754.5
	319.302
	 
	PT446
	SH
	668139.8
	937808.7
	317.523

	PT187
	SH
	668077.8
	937753.6
	319.218
	 
	PT447
	SH
	668142.5
	937806.5
	317.477

	PT188
	SH
	668078.5
	937746.8
	319.408
	 
	PT448
	SH
	668143.5
	937805.6
	317.641

	PT189
	SH
	668076.3
	937744
	319.51
	 
	PT449
	BLD
	668152.8
	937810.8
	317.334

	PT190
	SH
	668079.7
	937740.7
	319.611
	 
	PT450
	BLD
	668152.8
	937803.9
	317.388

	PT191
	SH
	668080.3
	937743.2
	319.569
	 
	PT451
	BLD
	668120.4
	937826.9
	317.189

	PT192
	SH
	668078.8
	937739.9
	319.631
	 
	PT452
	SH
	668123.3
	937828
	316.989

	PT193
	SH
	668078.8
	937737.1
	319.719
	 
	PT453
	SH
	668126.8
	937828.7
	316.943

	PT194
	SH
	668081
	937736.3
	319.732
	 
	PT454
	SH
	668126.3
	937832
	316.931

	PT195
	SH
	668078.1
	937736.2
	319.726
	 
	PT455
	SH
	668123.9
	937832.8
	316.937

	PT196
	SH
	668074.3
	937736.5
	319.73
	 
	PT456
	SH
	668121.8
	937833.5
	316.965

	PT197
	BLD
	668076
	937739.9
	319.718
	 
	PT457
	SH
	668128
	937833
	316.904

	PT198
	SH
	668070.5
	937735
	319.725
	 
	PT458
	SH
	668128.4
	937836.4
	316.889

	PT199
	SH
	668067.7
	937732.6
	319.769
	 
	PT459
	SH
	668135.6
	937832.3
	316.921

	PT200
	SH
	668065.8
	937735.6
	319.673
	 
	PT460
	SH
	668134.3
	937834.4
	316.926

	PT201
	SH
	668064.2
	937739.6
	319.579
	 
	PT461
	SH
	668138.4
	937829.2
	316.911

	PT202
	SH
	668061
	937736.3
	319.632
	 
	PT462
	SH
	668141.1
	937835.5
	316.628

	PT203
	SH
	668060.3
	937732.6
	319.705
	 
	PT463
	SH
	668120.5
	937838.7
	317.002

	PT204
	SH
	668057.4
	937735.8
	319.652
	 
	PT464
	BLD
	668073.3
	937862.2
	316.453

	PT205
	SH
	668056.3
	937739.5
	319.449
	 
	PT465
	SH
	668072.4
	937859
	316.477

	PT206
	SH
	668052.5
	937736.1
	319.664
	 
	PT466
	SH
	668069.5
	937857
	316.409

	PT207
	SH
	668050.9
	937732.6
	319.757
	 
	PT467
	SH
	668065.8
	937859.2
	316.319

	PT208
	SH
	668048.6
	937736.2
	319.724
	 
	PT468
	SH
	668064.3
	937857.5
	316.229

	PT209
	BLD
	668043.3
	937739.9
	319.659
	 
	PT469
	SH
	668063.9
	937853.2
	316.483

	PT210
	BLD
	668043.6
	937731.8
	319.686
	 
	PT470
	SH
	668055.7
	937859.2
	316.296

	PT211
	BLD
	668075.8
	937729.8
	319.966
	 
	PT471
	SH
	668050.3
	937854.7
	316.365

	PT212
	BLD
	668079.9
	937728.9
	320.175
	 
	PT472
	BLD
	668050.1
	937852.9
	316.654

	PT213
	BLD
	668079.7
	937763.4
	318.77
	 
	PT473
	SH
	668056.8
	937852.8
	316.47

	PT214
	SH
	668080.8
	937767.6
	318.711
	 
	PT474
	SH
	668063.8
	937852.2
	316.438

	PT215
	SH
	668083.6
	937771.3
	318.618
	 
	PT475
	SH
	668067.5
	937853.8
	316.473

	PT216
	CV
	668088.4
	937773.9
	318.388
	 
	PT476
	BLD
	668073.3
	937851.7
	316.674

	PT217
	CV
	668088.4
	937774.1
	318.401
	 
	PT477
	BLD
	668073.4
	937838.8
	317.02

	PT218
	CV
	668088.9
	937774.3
	318.362
	 
	PT478
	SH
	668071.2
	937834.5
	316.988

	PT219
	CV
	668089.2
	937774.2
	318.355
	 
	PT479
	SH
	668071.7
	937829.5
	317.224

	PT220
	CV
	668089.7
	937774
	318.348
	 
	PT480
	BLD
	668073.4
	937827.2
	317.205

	PT221
	CV
	668089.7
	937773.6
	318.358
	 
	PT481
	SH
	668067.6
	937828.1
	317.111

	PT222
	SH
	668092.5
	937776.3
	318.551
	 
	PT482
	SH
	668064.6
	937832.8
	317.034

	PT223
	SH
	668090.5
	937779.5
	318.338
	 
	PT483
	SH
	668061.8
	937837.4
	316.978

	PT224
	SH
	668092.9
	937780.6
	318.233
	 
	PT484
	SH
	668056.2
	937836.7
	316.98

	PT225
	SH
	668091.7
	937784.1
	318.136
	 
	PT485
	SH
	668057.4
	937831
	317.048

	PT226
	SH
	668090.5
	937787.6
	318.117
	 
	PT486
	SH
	668058.5
	937827.6
	317.15

	PT227
	SH
	668095.2
	937788.3
	318.215
	 
	PT487
	SH
	668050.6
	937828
	316.962

	PT228
	SH
	668098.3
	937788.8
	318.206
	 
	PT488
	SH
	668049.9
	937833.6
	316.97

	PT229
	SH
	668098.2
	937786.1
	318.204
	 
	PT489
	SH
	668049
	937837
	316.957

	PT230
	SH
	668097.9
	937782.4
	318.229
	 
	PT490
	BLD
	668043.9
	937838
	317.267

	PT231
	SH
	668097.4
	937777.8
	318.321
	 
	PT491
	BLD
	668073.7
	937792
	318.073

	PT232
	SH
	668097.1
	937773.1
	318.529
	 
	PT492
	SH
	668073.1
	937784.7
	318.318

	PT233
	SH
	668100.9
	937773.3
	318.58
	 
	PT493
	BD
	668073.2
	937780.3
	318.439

	PT234
	SH
	668102.2
	937777.1
	318.319
	 
	PT494
	SH
	668069.9
	937784.4
	318.355

	PT235
	SH
	668101.1
	937781.3
	318.285
	 
	PT495
	SH
	668064.9
	937790.3
	318.076

	PT236
	SH
	668100.2
	937785.2
	318.239
	 
	PT496
	SH
	668062.6
	937784.4
	318.262

	PT237
	SH
	668102.1
	937788.4
	318.071
	 
	PT497
	SH
	668061.5
	937781.1
	318.253

	PT238
	BLD
	668103.3
	937790.4
	317.873
	 
	PT498
	SH
	668054.5
	937781.3
	318.237

	PT239
	SH
	668105.1
	937786.6
	318.137
	 
	PT499
	SH
	668053
	937785.2
	318.171

	PT240
	SH
	668105.9
	937783.1
	318.189
	 
	PT500
	SH
	668051.4
	937789.3
	318.097

	PT241
	SH
	668106.2
	937778.4
	318.236
	 
	PT501
	SH
	668045
	937791.3
	318.148

	PT242
	SH
	668106.3
	937774.5
	318.368
	 
	PT502
	SH
	668044.7
	937785.9
	318.238

	PT243
	SH
	668106.4
	937771.7
	318.607
	 
	PT503
	BD
	668043.5
	937789.4
	318.204

	PT244
	SH
	668109.8
	937771.4
	318.611
	 
	PT504
	BD
	668046.8
	937781.7
	318.191

	PT245
	SH
	668114.7
	937770.8
	318.727
	 
	PT505
	SH
	668050.5
	937781.3
	318.192

	PT246
	CV
	668118.6
	937769.6
	318.768
	 
	PT506
	BLD
	668073.6
	937768.4
	318.52

	PT247
	CV
	668118.6
	937769.2
	318.875
	 
	PT507
	SH
	668072.8
	937765.9
	318.772

	PT248
	BLD
	668120.4
	937768.5
	318.906
	 
	PT508
	SH
	668068.1
	937767.9
	318.712

	PT249
	SH
	668118
	937771.4
	318.745
	 
	PT509
	SH
	668064.3
	937765.9
	318.846

	PT250
	SH
	668114.6
	937774.6
	318.45
	 
	PT510
	SH
	668061.8
	937764.8
	318.757

	PT251
	SH
	668112.3
	937778.2
	318.273
	 
	PT511
	SH
	668059.2
	937766.6
	318.779

	PT252
	SH
	668116.9
	937781
	318.219
	 
	PT512
	SH
	668056.8
	937767.3
	318.813

	PT253
	SH
	668114.7
	937784
	318.086
	 
	PT513
	SH
	668055.6
	937765.9
	317.208

	PT254
	SH
	668110.9
	937786.4
	318.028
	 
	PT514
	SH
	668054.7
	937765.1
	317.217

	PT255
	SH
	668108.3
	937788.8
	318.063
	 
	PT515
	SH
	668050.4
	937765
	317.161

	PT256
	SH
	668106.5
	937792.3
	317.922
	 
	PT516
	SH
	668048.2
	937766.1
	317.281

	PT257
	SH
	668104.3
	937794.3
	317.593
	 
	PT517
	SH
	668047.6
	937767.1
	318.799

	PT258
	SH
	668106.6
	937796.8
	317.885
	 
	PT518
	BLD
	668043.7
	937764.7
	322.083
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